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概要概要

Camel K のインストール、開発環境の設定、およびサンプルアプリケーションの実行方法を説明し
ます。
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前書き

多様性を受け入れるオープンソースの強化
Red Hat では、コード、ドキュメント、Web プロパティーにおける配慮に欠ける用語の置き換えに取り
組んでいます。まずは、マスター (master)、スレーブ (slave)、ブラックリスト (blacklist)、ホワイトリ
スト (whitelist) の 4 つの用語の置き換えから始めます。この取り組みは膨大な作業を要するため、今後
の複数のリリースで段階的に用語の置き換えを実施して参ります。詳細は、Red Hat CTO である Chris
Wright のメッセージ をご覧ください。

前書き前書き
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第1章 CAMEL K の紹介
本章では、Red Hat Integration - Camel K によって提供される概念、機能、およびクラウドネイティブ
アーキテクチャーについて紹介します。

「Camel K の概要」

「Camel K の機能」

「Kamelets」

「Camel K 開発ツール」

「Camel K ディストリビューション」

1.1. CAMEL K の概要

Red Hat Integration - Camel K は、OpenShift のクラウドでネイティブで実行される Apache Camel K
からビルドされる軽量のインテグレーションフレームワークです。Camel K は、サーバーレスおよびマ
イクロサービスアーキテクチャー向けに特別に設計されています。Camel K を使用すると、Camel
Domain Specific Language (DSL) で書かれたインテグレーションコードを直接 OpenShift で即座に実
行することができます。Camel K は Apache Camel オープンソースコミュニティーのサブプロジェクト
です (https://github.com/apache/camel-k)。

Camel K は Go プログラミング言語で実装され、Kubernetes Operator SDK を使用してクラウドにイン
テグレーションを自動的にデプロイします。たとえば、これには OpenShift でのサービスおよびルート
の自動作成が含まれます。これにより、クラウドにインテグレーションをデプロイおよび再デプロイす
る際に、ターンアラウンドタイムが大幅に短縮されます (たとえば、数分から数秒未満に削減されま
す)。

Camel K ランタイムは、パフォーマンスを最適化します。Quarkus のクラウドネイティブ Java フレー
ムワークは、起動時間を短縮し、メモリーおよび CPU フットプリントを削減するために、デフォルト
で有効になっています。Camel K を開発者モードで実行する場合、インテグレーションが再デプロイさ
れるまで待たずに、インテグレーション DSL のライブ更新を行うことができ、OpenShift のクラウド
で結果を即時に表示できます。

Camel K を OpenShift Serverless および Knative Serving とともに使用すると、コンテナーは必要な場
合のみ作成され、負荷の増減がゼロになるように自動スケーリングが使用されます。このため、サー
バーのプロビジョニングとメンテナンスのオーバーヘッドがなくなり、コストが削減されるため、アプ
リケーションの開発に集中することができます。

Camel K を OpenShift Serverless および Knative Eventing とともに使用すると、システムのコンポーネ
ントがサーバーレスアプリケーションのイベント駆動型アーキテクチャーで通信する方法を管理できま
す。これにより、パブリッシュ/サブスクライブモデルまたはイベントストリーミングモデルを使用し
たイベントプロデューサーとコンシューマー間の関係が切り離され、柔軟性と効率化を実現できます。

関連情報関連情報

Apache Camel K の Web サイト

OpenShift Serverless を使用してみる

1.2. CAMEL K の機能

Camel K には、以下の主要プラットフォームおよび機能が含まれています。

Red Hat Integration 2022.Q2 Camel K のスタートガイドのスタートガイド
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1.2.1. プラットフォームおよびコンポーネントのバージョン

OpenShift Container 4.6 または Platform 4.10

OpenShift Serverless 1.18.0

Quarkus 2.2 Java ランタイム

Apache Camel K 1.6.6

Apache Camel 3.11.1

Apache Camel Quarkus 2.2

OpenJDK 11

1.2.2. Camel K の機能

自動スケーリングおよびゼロへのスケーリングを行うための Knative Serving

イベント駆動型アーキテクチャーのための Knative Eventing

デフォルトで Quarkus ランタイムを使用するパフォーマンスの最適化

Java または YAML DSL で書かれた Camel インテグレーション

Visual Studio Code での開発ツール

OpenShift で Prometheus を使用したインテグレーションのモニタリング

クイックスタートチュートリアル

AWS、Jira、Salesforce などの外部システムへのコネクターの Kamelet Catalog

以下は、Camel K クラウドネイティブアーキテクチャーを簡単に表した図になります。

関連情報関連情報

Apache Camel architecture

第第1章章 CAMEL K の紹介の紹介

5

https://camel.apache.org/camel-k/latest/architecture/architecture.html


1.2.3. Kamelets

Kamelets は、Camel に精通していないユーザーであっても、インスタンス化するために必要なすべて
の情報が含まれるシンプルなインターフェイスを使用することで、複雑な外部システムへの接続を単純
化します。

Kamelets は、OpenShift クラスターにインストールでき、Camel K インテグレーションで使用できる
カスタムリソースとして実装されます。Kamelets は、コンポーネントの詳細な理解なしに外部システ
ムに接続するために設計された Camel コンポーネントを使用するルートテンプレートです。Kamelets
は、外部システムへ接続する詳細を抽象化します。また、Kamelets を組み合わせることで、標準の
Camel コンポーネントを使用するのと同じように、複雑な Camel インテグレーションを作成すること
もできます。

関連情報関連情報

アプリケーションの Kamelets との統合

1.3. CAMEL K 開発ツール

Camel K は、Visual Studio (VS) Code、Visual Studio (VS) Code、Red Hat CodeReady WorkSpaces、
および Eclipse Che の開発ツールエクステンションを提供します。Camel ベースのツールエクステン
ションには、Camel DSL コードの自動補完、Camel K モードライン設定、Camel K トレイトなどの機
能が含まれます。Didact チュートリアルツールエクステンションは、Camel K クイックスタートの
チュートリアルコマンドを自動実行します。

以下の VS Code 開発ツールエクステンションを使用できます。

Red Hat による Apache Camel の VS Code エクステンションパック

Apache Camel K エクステンションのツール

Apache Camel エクステンションの言語サポート

OpenShift、Java 等の追加エクステンション

VS Code エクステンションの Didact チュートリアルツール

Camel K にこれらの VS Code エクステンションを設定する方法の詳細は、Camel K 開発環境の設定  を
参照してください。

注記注記: Camel K VS Code エクステンションはコミュニティー機能です。

Red Hat CodeReady Workspaces および Eclipse Che も、vscode-camelk プラグインを使用してこれら
の機能を提供します。

関連情報関連情報

Red Hat エクステンションによる Apache Camel K の VS Code ツール

Apache Camel K サンプルの VS Code ツール

Apache Camel K の Eclipse Che ツール

Red Hat CodeReady WorkSpaces クラウドツール

Red Hat Integration 2022.Q2 Camel K のスタートガイドのスタートガイド
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1.4. CAMEL K ディストリビューション

表表1.1 Red Hat Integration - Camel K ディストリビューションディストリビューション

ディストリビューションディストリビューション 説明説明 場所場所

Operator イメージ Red Hat Integration - Camel K
Operator のコンテナーイメージ: 
integration/camel-k-rhel8-
operator

Operators → 
OperatorHub の
OpenShift Web コンソー
ル

registry.redhat.io

Maven リポジトリー Red Hat Integration - Camel K の
Maven アーティファクト

Red Hat は、Red Hat 製品に同梱
されているコンテンツをホストす
る Maven リポジトリーを提供し
ます。これらのリポジトリーは、
ソフトウェアダウンロードページ
からダウンロードできます。

Red Hat Integration - Camel K の
場合、以下のリポジトリーが必要
です。

rhi-common

rhi-camel-quarkus

rhi-camel-k

本リリースでは、Red Hat
Integration - Camel K をオフライ
ンモードでインストールすること
はサポートされません。

Red Hat Integration のソフトウェ
アダウンロード

ソースコード Red Hat Integration - Camel K の
ソースコード

Red Hat Integration のソフトウェ
アダウンロード

第第1章章 CAMEL K の紹介の紹介

7

https://catalog.redhat.com/software/containers/detail/60d1981b4924e14519331a1b?container-tabs=gti&gti-tabs=registry-tokens
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クイックスタート クイックスタートチュートリアル:

基本的な Java インテグ
レーション

イベントストリーミング
のインテグレーション

JDBC インテグレーショ
ン

JMS インテグレーショ
ン

Kafka インテグレーショ
ン

Knative のインテグレー
ション

SaaS のインテグレー
ション

Serverless API のインテ
グレーション

変換のインテグレーショ
ン

https://github.com/openshift-
integration

ディストリビューションディストリビューション 説明説明 場所場所

注記注記

Red Hat Integration - Camel K ディストリビューションにアクセスするには、Red Hat
Integration のサブスクリプションが必要で、Red Hat カスタマーポータルにログインす
る必要があります。
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第2章 OPENSHIFT クラスターの準備
本章では、Red Hat Integration - Camel K および OpenShift Serverless を OpenShift にインストールす
る方法と、開発環境に必要な Camel K および OpenShift Serverless コマンドラインクライアントツール
をインストールする方法について説明します。

「Camel K のインストール」

「OpenShift Serverless のインストール」

2.1. CAMEL K のインストール

OperatorHub から OpenShift クラスターで Red Hat Integration - Camel K Operator をインストールで
きます。OperatorHub は OpenShift Container Platform Web コンソールから使用でき、クラスター管
理者が Operator を検出およびインストールするためのインターフェイスを提供します。

Camel K Operator のインストール後に、コマンドラインですべての Camel K 機能にアクセスする
Camel K CLI ツールをインストールできます。

前提条件前提条件

適切なアクセスレベルで OpenShift 4.6 (またはそれ以降の) クラスターにアクセスできるこ
と。この場合、プロジェクトの作成および Operator のインストールができること。また、CLI
ツールをローカルシステムにインストールできること。

注記注記

OpenShift OperatorHub から Camel K をインストールする場合は、プルシーク
レットを作成する必要はありません。Camel K Operator は OpenShift クラス
ターレベルの認証を自動的に再利用して、registry.redhat.io から Camel K イ
メージをプルします。

コマンドラインで OpenShift クラスターと対話できるように OpenShift CLI ツール (oc) をイン
ストールしていること。OpenShift CLI のインストール方法の詳細は、Installing the OpenShift
CLI を参照してください。

手順手順

1. OpenShift Container Platform Web コンソールで、クラスター管理者権限を持つアカウントを
使用してログインします。

2. 新しい OpenShift プロジェクトを作成します。

a. 左側のナビゲーションメニューで、Home > Project > Create Project とクリックします。

b. プロジェクト名 (例: my-camel-k-project) を入力し、Create をクリックします。

3. 左側のナビゲーションメニューで、Operators > OperatorHub とクリックします。

4. Filter by keyword テキストボックスに Camel K を入力し、Red Hat Integration - Camel K
Operator カードをクリックします。

5. Operator に関する情報を確認し、続いて Install をクリックします。Operator インストール
ページが開きます。
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6. 以下のサブスクリプション設定を選択します。

Update Channel > latest

Installation Mode > A specific namespace on the cluster > my-camel-k-project

Approval Strategy > Automatic

注記注記

ご使用の環境で必要な場合は Installation mode > All namespaces on the
cluster および Approval Strategy > Manual 設定も使用できます。

7. Install をクリックし、その後 Camel K Operator が使用できるようになるまでしばらく待ちま
す。

8. Camel K CLI ツールをダウンロードし、インストールします。

a. OpenShift Web コンソールの上部にある Help メニュー (?) から、Command line tools を
選択します。

b. kamel - Red Hat Integration - Camel K - Command Line Interface セクションまでスク
ロールダウンします。

c. ローカルのオペレーティングシステム (Linux、Mac、Windows) のバイナリーをダウンロー
ドするためのリンクをクリックします。

d. CLI をデプロイメントしてシステムパスにインストールします。

e. Kamel K CLI にアクセスできることを確認するには、コマンドウィンドウを開き、以下のコ
マンドを入力します。
kamel --help

このコマンドは、Camel K CLI コマンドに関する情報を表示します。

次のステップ次のステップ

(オプション) Camel K リソース制限の指定

2.1.1. Camel K リソース制限の指定

Camel K をインストールする場合、Camel K 用の OpenShift Pod には、CPU およびメモリー (RAM) リ
ソースの制限がありません。Camel K のリソース制限を定義する場合は、インストールプロセスで作成
された Camel K サブスクリプションリソースを編集する必要があります。

前提条件前提条件

Camel K のインストール  で説明されているように、Camel K Operator がインストールされてい
る OpenShift プロジェクトにクラスター管理者としてアクセスできる。

Camel K サブスクリプションに適用するリソース制限を把握している。リソース制限の詳細
は、以下のドキュメントを参照してください。

OpenShift ドキュメントの Setting deployment resources

Kubernetes ドキュメントの Managing Resources for Containers
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手順手順

1. OpenShift Web コンソールにログインします。

2. Operators > Installed Operators > Operator Details > Subscription の順に選択します。

3. Actions > Edit Subscription を選択します。
YAML エディターでサブスクリプションのファイルが開きます。

4. spec セクションで、以下の例のように config.resources セクションを追加し、メモリーと
CPU の値を指定します。

spec:
  channel: default
  config:
    resources:
      limits:
        memory: 512Mi
        cpu: 500m
      requests:
        cpu: 200m
        memory: 128Mi

5. 変更を保存します。

OpenShift はサブスクリプションを更新し、指定したリソース制限を適用します。

2.2. OPENSHIFT SERVERLESS のインストール

OperatorHub から OpenShift クラスターに OpenShift Serverless Operator をインストールできます。
OperatorHub は OpenShift Container Platform Web コンソールから使用でき、クラスター管理者が
Operator を検出およびインストールするためのインターフェイスを提供します。

OpenShift Serverless Operator は、Knative Serving および Knative Eventing 機能の両方をサポートし
ます。詳細は、installing OpenShift Serverless Operator を参照してください。

前提条件前提条件

Camel K Operator がインストールされている OpenShift プロジェクトにクラスター管理者とし
てアクセスできる。

コマンドラインで OpenShift クラスターと対話できるように OpenShift CLI ツール (oc) をイン
ストールしていること。OpenShift CLI のインストール方法の詳細は、Installing the OpenShift
CLI を参照してください。

手順手順

1. OpenShift Container Platform Web コンソールで、クラスター管理者権限を持つアカウントを
使用してログインします。

2. 左側のナビゲーションメニューで、Operators > OperatorHub とクリックします。

3. Filter by keyword テキストボックスで Serverless を入力し、OpenShift Serverless Operator
を見つけます。

4. Operator に関する情報を読み、Install をクリックして Operator サブスクリプションページを

第第2章章 OPENSHIFT クラスターの準備クラスターの準備

11

https://access.redhat.com/documentation/ja-jp/openshift_container_platform/4.10/html-single/serverless/index#install
https://access.redhat.com/documentation/ja-jp/openshift_container_platform/4.10/html-single/cli_tools/index#installing-openshift-cli


4. Operator に関する情報を読み、Install をクリックして Operator サブスクリプションページを
表示します。

5. デフォルトのサブスクリプション設定を選択します。

Update Channel > OpenShift バージョンと一致するチャンネルを選択 (4.10 など)

Installation Mode > All namespaces on the cluster

Approval Strategy > Automatic

注記注記

ご使用の環境で必要な場合は Approval Strategy > Manual 設定も使用でき
ます。

6. Install をクリックし、Operator が使用できるようになるまでしばらく待ちます。

7. OpenShift ドキュメントの手順に従って、必要な Knative コンポーネントをインストールしま
す。

Knative Serving のインストール

Knative Eventing のインストール

8. (任意) OpenShift Serverless CLI ツールをダウンロードし、インストールします。

a. OpenShift Web コンソールの上部にある Help メニュー (?) から、Command line tools を
選択します。

b. kn - OpenShift Serverless - Command Line Interface セクションまでスクロールダウンし
ます。

c. ローカルのオペレーティングシステム (Linux、Mac、Windows) のバイナリーをダウンロー
ドするためのリンクをクリックします。

d. CLI をデプロイメントしてシステムパスにインストールします。

e. kn CLI にアクセスできることを確認するには、コマンドウィンドウを開き、以下のコマン
ドを入力します。
kn --help

このコマンドは、OpenShift Serverless CLI コマンドに関する情報を表示します。

詳細は、OpenShift Serverless CLI documentation を参照してください。

関連情報関連情報

OpenShift ドキュメントの Installing OpenShift Serverless

2.3. CAMEL K の MAVEN リポジトリーの設定

Camel K オペレーターの場合、ConfigMap またはシークレットで Maven 設定を提供できます。

手順手順

Red Hat Integration 2022.Q2 Camel K のスタートガイドのスタートガイド
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1. ファイルから ConfigMap を作成するには、次のコマンドを実行します。

oc create configmap maven-settings --from-file=settings.xml

作成された ConfigMap は、spec.build.maven.settings フィールドから IntegrationPlatform
リソースで参照できます。

例例

apiVersion: camel.apache.org/v1
kind: IntegrationPlatform
metadata:
  name: camel-k
spec:
  build:
     maven:
        settings:
           configMapKeyRef:
                key: settings.xml
                name: maven-settings

または、次のコマンドを使用して、IntegrationPlatform リソースを直接編集し、Maven 設定
を含む ConfigMap を参照することができます。

oc edit ip camel-k

リモートリモート Maven リポジトリーのリポジトリーの CA 証明書の設定証明書の設定

Maven コマンドがリモート Maven リポジトリーに接続するために使用する CA 証明書をシークレット
で提供できます。

手順手順

1. 次のコマンドを使用して、ファイルからシークレットを作成します。

oc create secret generic maven-ca-certs --from-file=ca.crt

2. 以下に示すように、spec.build.maven.caSecret フィールドから、IntegrationPlatform リソー
スで作成したシークレットを参照します。

apiVersion: camel.apache.org/v1
kind: IntegrationPlatform
metadata:
  name: camel-k
spec:
  build:
      maven:
          caSecret:
             key: tls.crt
             name: tls-secret
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第3章 CAMEL K インテグレーションの開発および実行
本章では、開発環境を設定する方法と、Java および YAML で書かれた簡単な Camel K インテグレー
ションを開発およびデプロイする方法を説明します。また、kamel コマンドラインを使用して起動時に
Camel K インテグレーションを管理する方法も説明します。たとえば、これには、インテグレーション
の実行、記述、ログ、および削除が含まれます。

「Camel K 開発環境の設定」

「Java での Camel K インテグレーションの開発」

「YAML での Camel K インテグレーションの開発」

「Camel K インテグレーションの実行」

「開発モードでの Camel K インテグレーションの実行」

「モードラインを使用した Camel K インテグレーションの実行」

3.1. CAMEL K 開発環境の設定

Camel K クイックスタートチュートリアルを自動的にデプロイする前に、推奨される開発ツールで環境
を設定する必要があります。ここでは、推奨の Visual Studio (VS) コード IDE と Camel K に提供される
エクステンションをインストールする方法について説明します。

注記注記

Camel K VS Code エクステンションはコミュニティー機能です。

VS Code は使いやすく、Camel K の開発者エクスペリエンスが優れているため
推奨されます。これには、Camel DSL コードと Camel K トレイトの自動補完
や、チュートリアルのコマンドの自動実行が含まれます。ただし、VS Code の
代わりに選択した IDE を使用して、コードおよびチュートリアルコマンドを手動
で入力することができます。

前提条件前提条件

Camel K Operator および OpenShift Serverless Operator がインストールされている OpenShift
クラスターにアクセスできる必要があります。

Camel K のインストール

OperatorHub からの OpenShift Serverless のインストール

手順手順

1. 開発プラットフォームに VS Code をインストールします。たとえば、Red Hat Enterprise Linux
の場合は次のようにインストールします。

a. 必要なキーおよびリポジトリーをインストールします。

$ sudo rpm --import https://packages.microsoft.com/keys/microsoft.asc
$ sudo sh -c 'echo -e "[code]\nname=Visual Studio 
Code\nbaseurl=https://packages.microsoft.com/yumrepos/vscode\nenabled=1\ngpgcheck=1
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b. キャッシュを更新し、VS Code パッケージをインストールします。

他のプラットフォームにインストールする場合の詳細は、VS Code のインストールに関す
るドキュメント を参照してください。

2. code コマンドを入力して VS Code エディターを起動します。詳細は、VS Code コマンドライ
ンのドキュメント を参照してください。

3. Camel K に必要なエクステンションが含まれる VS Code Camel Extension Pack をインストール
します。たとえば、VS Code で以下を行います。

a. 左側のナビゲーションバーで Extensions をクリックします。

b. 検索ボックスに Apache Camel と入力します。

c. Extension Pack for Apache Camel by Red Hat を選択し、Install をクリックします。

詳細は、RExtension Pack for Apache Camel by Red Hat  手順を参照してください。

4. VS Code Didact エクステンションをインストールします。これを使用すると、チュートリアル
のリンクをクリックしてクイックスタートのチュートリアルコマンドを自動的に実行できま
す。たとえば、VS Code で以下を行います。

a. 左側のナビゲーションバーで Extensions をクリックします。

b. 検索ボックスに Didact と入力します。

c. エクステンションを選択し、Install をクリックします。
詳細は、Didact エクステンション の説明を参照してください。

関連情報関連情報

VS Code の Getting Started

Red Hat エクステンションによる Apache Camel K の VS Code ツール

\ngpgkey=https://packages.microsoft.com/keys/microsoft.asc" > 
/etc/yum.repos.d/vscode.repo'

$ yum check-update
$ sudo yum install code
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Red Hat エクステンションによる Apache Camel の VS Code 言語サポート

Apache Camel K および VS Code ツールの例

3.2. JAVA での CAMEL K インテグレーションの開発

ここでは、Java DSL で簡単な Camel K インテグレーションを開発する方法を説明します。Camel K を
使用して、Java でデプロイするインテグレーションを作成することは、Camel でルーティングルール
を定義することと同じです。しかし、Camel K を使用する場合は、インテグレーションを JAR として
ビルドおよびパッケージ化する必要はありません。

インテグレーションルートで Camel コンポーネントを直接使用できます。Camel K は依存関係管理を
自動的に処理し、コード検査を使用して Camel カタログから必要なライブラリーをすべてインポート
します。

前提条件前提条件

Camel K 開発環境の設定

手順手順

1. kamel init コマンドを入力して、簡単な Java インテグレーションファイルを生成します。以下
に例を示します。

2. IDE で生成されたインテグレーションファイルを開き、必要に応じて編集します。たとえば、
すぐに使えるように、HelloCamelK.java インテグレーションには Camel timer および log コ
ンポーネントが自動的に含まれます。

次のステップ次のステップ

Camel K インテグレーションの実行

3.3. YAML での CAMEL K インテグレーションの開発

$ kamel init HelloCamelK.java

// camel-k: language=java

import org.apache.camel.builder.RouteBuilder;

public class HelloCamelK extends RouteBuilder {
  @Override
  public void configure() throws Exception {

      // Write your routes here, for example:
      from("timer:java?period=1s")
        .routeId("java")
        .setBody()
          .simple("Hello Camel K from ${routeId}")
        .to("log:info");

  }
}
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ここでは、YAML DSL で簡単な Camel K インテグレーションを開発する方法を説明します。Camel K
を使用して、デプロイするインテグレーションを YAML で作成することは、Camel でルーティング
ルールを定義することと同じです。

インテグレーションルートで Camel コンポーネントを直接使用できます。Camel K は依存関係管理を
自動的に処理し、コード検査を使用して Camel カタログから必要なライブラリーをすべてインポート
します。

前提条件前提条件

Camel K 開発環境の設定

手順手順

1. kamel init コマンドを入力して、簡単な YAML インテグレーションファイルを生成します。以
下に例を示します。

2. IDE で生成されたインテグレーションファイルを開き、必要に応じて編集します。たとえば、
すぐに使えるように、hello.camelk.yaml インテグレーションには Camel timer および log コ
ンポーネントが自動的に含まれます。

3.4. CAMEL K インテグレーションの実行

kamel run コマンドを使用すると、コマンドラインから OpenShift クラスターのクラウドで Camel K
インテグレーションを実行できます。

前提条件前提条件

Camel K 開発環境の設定

Java または YAML DSL で記述された Camel インテグレーションが作成済みである。

手順手順

1. 以下の例のように、oc クライアントツールを使用して OpenShift クラスターにログインしま
す。

2. 以下の例のように、Camel K Operator が稼働していることを確認します。

$ kamel init hello.camelk.yaml

# Write your routes here, for example:
- from:
    uri: "timer:yaml"
    parameters:
      period: "1s"
    steps:
      - set-body:
          constant: "Hello Camel K from yaml"
      - to: "log:info"

$ oc login --token=my-token --server=https://my-cluster.example.com:6443
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3. kamel run コマンドを入力し、OpenShift のクラウドでインテグレーションを実行します。以
下に例を示します。

Java の例の例

YAML の例の例

4. kamel get コマンドを入力し、インテグレーションの状態を確認します。

インテグレーションが初めて実行されると、Camel K はコンテナーイメージのインテグレー
ションキットをビルドします。インテグレーションキットは、必要なすべての Camel モジュー
ルをダウンロードし、イメージクラスパスに追加します。

5. kamel get を再度入力して、インテグレーションが稼働していることを確認します。

6. kamel log コマンドを入力して、ログを stdout に出力します。

$ oc get pod
NAME                               READY   STATUS    RESTARTS   AGE
camel-k-operator-86b8d94b4-pk7d6   1/1     Running   0          6m28s

$ kamel run HelloCamelK.java
integration "hello-camel-k" created

$ kamel run hello.camelk.yaml
integration "hello" created

$ kamel get
NAME       PHASE           KIT
hello      Building Kit    myproject/kit-bq666mjej725sk8sn12g

$ kamel get
NAME       PHASE   KIT
hello      Running myproject/kit-bq666mjej725sk8sn12g

$ kamel log hello
[1] 2021-08-11 17:58:40,573 INFO  [org.apa.cam.k.Runtime] (main) Apache Camel K 
Runtime 1.7.1.fuse-800025-redhat-00001
[1] 2021-08-11 17:58:40,653 INFO  [org.apa.cam.qua.cor.CamelBootstrapRecorder] (main) 
bootstrap runtime: org.apache.camel.quarkus.main.CamelMainRuntime
[1] 2021-08-11 17:58:40,844 INFO  [org.apa.cam.k.lis.SourcesConfigurer] (main) Loading 
routes from: SourceDefinition{name='camel-k-embedded-flow', language='yaml', 
location='file:/etc/camel/sources/camel-k-embedded-flow.yaml', }
[1] 2021-08-11 17:58:41,216 INFO  [org.apa.cam.imp.eng.AbstractCamelContext] (main) 
Routes startup summary (total:1 started:1)
[1] 2021-08-11 17:58:41,217 INFO  [org.apa.cam.imp.eng.AbstractCamelContext] (main)     
Started route1 (timer://yaml)
[1] 2021-08-11 17:58:41,217 INFO  [org.apa.cam.imp.eng.AbstractCamelContext] (main) 
Apache Camel 3.10.0.fuse-800010-redhat-00001 (camel-1) started in 136ms (build:0ms 
init:100ms start:36ms)
[1] 2021-08-11 17:58:41,268 INFO  [io.quarkus] (main) camel-k-integration 1.6.6 on JVM 
(powered by Quarkus 1.11.7.Final-redhat-00009) started in 2.064s.
[1] 2021-08-11 17:58:41,269 INFO  [io.quarkus] (main) Profile prod activated.
[1] 2021-08-11 17:58:41,269 INFO  [io.quarkus] (main) Installed features: [camel-bean, 
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7. Ctrl-C キーを押して、ターミナルでログインを終了します。

関連情報関連情報

kamel run コマンドの詳細については、kamel run --help を入力してください。

デプロイメントのターンアラウンド時間を短縮するには、開発モードでの Camel K インテグ
レーションの実行 を参照してください。

インテグレーションを実行するための開発ツールの詳細は、Red Hat による Apache Camel K
の VS Code ツール を参照してください。

Camel K インテグレーションの管理  も参照してください。

3.5. 開発モードでの CAMEL K インテグレーションの実行

開発モードの Camel K インテグレーションは、コマンドラインから OpenShift クラスターで実行でき
ます。開発モードを使用すると、開発段階でインテグレーションを迅速に繰り返すことができ、コード
に関するフィードバックを即座に受け取ることができます。

--dev オプションを指定して kamel run コマンドを実行すると、インテグレーションがクラウドで即座
にデプロイされ、ターミナルにインテグレーションログが表示されます。次に、コードを変更でき、変
更が自動的かつ即座に OpenShift のリモートインテグレーション Pod に適用されることを確認できま
す。ターミナルには、クラウドのリモートインテグレーションの再デプロイメントすべてが自動的に表
示されます。

注記注記

開発モードで Camel K によって生成されたアーティファクトは、実稼働環境で実行する
アーティファクトと同じです。開発モードの目的は、より迅速な開発を行うことです。

前提条件前提条件

Camel K 開発環境の設定

Java または YAML DSL で記述された Camel インテグレーションが作成済みである。

手順手順

1. 以下の例のように、oc クライアントツールを使用して OpenShift クラスターにログインしま
す。

2. 以下の例のように、Camel K Operator が稼働していることを確認します。

camel-core, camel-k-core, camel-k-runtime, camel-log, camel-support-common, camel-timer, 
camel-yaml-dsl, cdi]
[1] 2021-08-11 17:58:42,423 INFO  [info] (Camel (camel-1) thread #0 - timer://yaml) 
Exchange[ExchangePattern: InOnly, BodyType: String, Body: Hello Camel K from yaml]
...

$ oc login --token=my-token --server=https://my-cluster.example.com:6443
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3. kamel run コマンドと --dev を入力し、クラウドの OpenShift にて開発モードでインテグレー
ションを実行します。以下は、簡単な Java の例になります。

$ oc get pod
NAME                               READY   STATUS    RESTARTS   AGE
camel-k-operator-86b8d94b4-pk7d6   1/1     Running   0          6m28s

$ kamel run HelloCamelK.java --dev
Condition "IntegrationPlatformAvailable" is "True" for Integration hello-camel-k: test/camel-k
Integration hello-camel-k in phase "Initialization"
Integration hello-camel-k in phase "Building Kit"
Condition "IntegrationKitAvailable" is "True" for Integration hello-camel-k: kit-
c49sqn4apkb4qgn55ak0
Integration hello-camel-k in phase "Deploying"
Progress: integration "hello-camel-k" in phase Initialization
Progress: integration "hello-camel-k" in phase Building Kit
Progress: integration "hello-camel-k" in phase Deploying
Integration hello-camel-k in phase "Running"
Condition "DeploymentAvailable" is "True" for Integration hello-camel-k: deployment name is 
hello-camel-k
Progress: integration "hello-camel-k" in phase Running
Condition "CronJobAvailable" is "False" for Integration hello-camel-k: different controller 
strategy used (deployment)
Condition "KnativeServiceAvailable" is "False" for Integration hello-camel-k: different 
controller strategy used (deployment)
Condition "Ready" is "False" for Integration hello-camel-k
Condition "Ready" is "True" for Integration hello-camel-k
[1] Monitoring pod hello-camel-k-7f85df47b8-js7cb
...
...
[1] 2021-08-11 18:34:44,069 INFO  [org.apa.cam.k.Runtime] (main) Apache Camel K 
Runtime 1.7.1.fuse-800025-redhat-00001
[1] 2021-08-11 18:34:44,167 INFO  [org.apa.cam.qua.cor.CamelBootstrapRecorder] (main) 
bootstrap runtime: org.apache.camel.quarkus.main.CamelMainRuntime
[1] 2021-08-11 18:34:44,362 INFO  [org.apa.cam.k.lis.SourcesConfigurer] (main) Loading 
routes from: SourceDefinition{name='HelloCamelK', language='java', 
location='file:/etc/camel/sources/HelloCamelK.java', }
[1] 2021-08-11 18:34:46,180 INFO  [org.apa.cam.imp.eng.AbstractCamelContext] (main) 
Routes startup summary (total:1 started:1)
[1] 2021-08-11 18:34:46,180 INFO  [org.apa.cam.imp.eng.AbstractCamelContext] (main)     
Started java (timer://java)
[1] 2021-08-11 18:34:46,180 INFO  [org.apa.cam.imp.eng.AbstractCamelContext] (main) 
Apache Camel 3.10.0.fuse-800010-redhat-00001 (camel-1) started in 243ms (build:0ms 
init:213ms start:30ms)
[1] 2021-08-11 18:34:46,190 INFO  [io.quarkus] (main) camel-k-integration 1.6.6 on JVM 
(powered by Quarkus 1.11.7.Final-redhat-00009) started in 3.457s.
[1] 2021-08-11 18:34:46,190 INFO  [io.quarkus] (main) Profile prod activated.
[1] 2021-08-11 18:34:46,191 INFO  [io.quarkus] (main) Installed features: [camel-bean, 
camel-core, camel-java-joor-dsl, camel-k-core, camel-k-runtime, camel-log, camel-support-
common, camel-timer, cdi]
[1] 2021-08-11 18:34:47,200 INFO  [info] (Camel (camel-1) thread #0 - timer://java) 
Exchange[ExchangePattern: InOnly, BodyType: String, Body: Hello Camel K from java]
[1] 2021-08-11 18:34:48,180 INFO  [info] (Camel (camel-1) thread #0 - timer://java) 
Exchange[ExchangePattern: InOnly, BodyType: String, Body: Hello Camel K from java]
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4. インテグレーション DSL ファイルの内容を編集し、変更を保存します。ターミナルで変更が即
座に表示されることを確認します。以下に例を示します。

5. Ctrl-C キーを押して、ターミナルでログインを終了します。

関連情報関連情報

kamel run コマンドの詳細については、kamel run --help を入力してください。

インテグレーションを実行するための開発ツールの詳細は、Red Hat による Apache Camel K
の VS Code ツール を参照してください。

Camel K インテグレーションの管理

Camel K インテグレーション依存関係の設定

3.6. モードラインを使用した CAMEL K インテグレーションの実行

Camel K モードラインを使用すると、起動時に実行される Camel K インテグレーションソースファイル
に複数の設定オプションを指定できます。これにより、複数のコマンドラインオプションを再入力する
時間を節約できるため効率を良くすることができ、入力エラーを防ぐことができます。

以下の例は、3scale を有効にし、インテグレーションコンテナーのメモリーを制限する Java インテグ

[1] 2021-08-11 18:34:49,180 INFO  [info] (Camel (camel-1) thread #0 - timer://java) 
Exchange[ExchangePattern: InOnly, BodyType: String, Body: Hello Camel K from java]
...

...
integration "hello-camel-k" updated
...
[2] 2021-08-11 18:40:54,173 INFO  [org.apa.cam.k.Runtime] (main) Apache Camel K 
Runtime 1.7.1.fuse-800025-redhat-00001
[2] 2021-08-11 18:40:54,209 INFO  [org.apa.cam.qua.cor.CamelBootstrapRecorder] (main) 
bootstrap runtime: org.apache.camel.quarkus.main.CamelMainRuntime
[2] 2021-08-11 18:40:54,301 INFO  [org.apa.cam.k.lis.SourcesConfigurer] (main) Loading 
routes from: SourceDefinition{name='HelloCamelK', language='java', 
location='file:/etc/camel/sources/HelloCamelK.java', }
[2] 2021-08-11 18:40:55,796 INFO  [org.apa.cam.imp.eng.AbstractCamelContext] (main) 
Routes startup summary (total:1 started:1)
[2] 2021-08-11 18:40:55,796 INFO  [org.apa.cam.imp.eng.AbstractCamelContext] (main)     
Started java (timer://java)
[2] 2021-08-11 18:40:55,797 INFO  [org.apa.cam.imp.eng.AbstractCamelContext] (main) 
Apache Camel 3.10.0.fuse-800010-redhat-00001 (camel-1) started in 174ms (build:0ms 
init:147ms start:27ms)
[2] 2021-08-11 18:40:55,803 INFO  [io.quarkus] (main) camel-k-integration 1.6.6 on JVM 
(powered by Quarkus 1.11.7.Final-redhat-00009) started in 3.025s.
[2] 2021-08-11 18:40:55,808 INFO  [io.quarkus] (main) Profile prod activated.
[2] 2021-08-11 18:40:55,809 INFO  [io.quarkus] (main) Installed features: [camel-bean, 
camel-core, camel-java-joor-dsl, camel-k-core, camel-k-runtime, camel-log, camel-support-
common, camel-timer, cdi]
[2] 2021-08-11 18:40:56,810 INFO  [info] (Camel (camel-1) thread #0 - timer://java) 
Exchange[ExchangePattern: InOnly, BodyType: String, Body: Hello Camel K from java]
[2] 2021-08-11 18:40:57,793 INFO  [info] (Camel (camel-1) thread #0 - timer://java) 
Exchange[ExchangePattern: InOnly, BodyType: String, Body: Hello Camel K from java]
...
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1

以下の例は、3scale を有効にし、インテグレーションコンテナーのメモリーを制限する Java インテグ
レーションファイルからのモードラインエントリーを示しています。

前提条件前提条件

Camel K 開発環境の設定

Java または YAML DSL で記述された Camel インテグレーションが作成済みである。

手順手順

1. Camel K モードラインエントリーをインテグレーションファイルに追加します。以下に例を示
します。

ThreeScaleRest.java

コンテナーと 3scale トレイトの両方を有効にし、3scale からルートを公開し、コンテ
ナーメモリーを制限します。

2. インテグレーションを実行します。以下に例を示します。

kamel run ThreeScaleRest.java

kamel run コマンドは、インテグレーションで指定されたモードオプションを出力します。以
下に例を示します。

関連情報関連情報

Camel K モードラインオプション

モードラインのインテグレーションを実行するための開発ツールの詳細は、Introducing IDE
support for Apache Camel K Modeline を参照してください。

// camel-k: trait=3scale.enabled=true trait=container.limit-memory=256Mi 1
import org.apache.camel.builder.RouteBuilder;

public class ThreeScaleRest extends RouteBuilder {

  @Override
  public void configure() throws Exception {
      rest().get("/")
        .route()
        .setBody().constant("Hello");
  }
}

Modeline options have been loaded from source files
Full command: kamel run ThreeScaleRest.java --trait=3scale.enabled=true --
trait=container.limit-memory=256Mi
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第4章 CAMEL K のアップグレード
インストールされた Camel K Operator を自動的にアップグレードできますが、Camel K インテグレー
ションは自動的にアップグレードされません。Camel K インテグレーションのアップグレードを手動で
トリガーする必要があります。本章では、Camel K Operator と Camel K インテグレーションの両方を
アップグレードする方法を説明します。

4.1. CAMEL K OPERATOR のアップグレード

インストールされた Camel K Operator のサブスクリプションは、Operator の更新を追跡し、受信する
ために使用される更新チャネル (例: 1.6.0 チャネル) を指定します。Operator をアップグレードして新
規チャネルからの更新の追跡および受信を開始するために、サブスクリプションで更新チャネルを変更
できます。インストールされた Operator の更新チャネルの変更に関する詳細は、Upgrading installed
operators を参照してください。

注記注記

インストールされた Operator は、現在のチャネルよりも古いチャネルに切り換
えることはできません。

サブスクリプションの承認ストラテジーが Automatic に設定されている場合、アップグレードプロセス
は、選択したチャネルで新規 Operator バージョンが利用可能になるとすぐに開始します。承認ストラ
テジーが Manual に設定されている場合、保留中のアップグレードを手動で承認する必要があります。

前提条件前提条件

Camel K Operator が Operator Lifecycle Manager (OLM) を使用してインストールされてい
る。

手順手順

1. OpenShift Container Platform Web コンソールの Administrator パースペクティブ
で、Operators → Installed Operators に移動します。

2. Camel K Operator をクリックします。

3. Subscription タブをクリックします。

4. Channel の下にある更新チャネルの名前をクリックします。

5. 変更する新しい更新チャネルをクリックします。たとえば、latest です。Save をクリックしま
す。これにより、最新の Camel K バージョンへのアップグレードが開始されます。

Automatic 承認ストラテジーのあるサブスクリプションの場合、アップグレードは自動的に開始しま
す。Operators → Installed Operatorsページに戻り、アップグレードの進捗をモニターします。完了時
に、ステータスは Succeeded および Up to date に変更されます。

Manual 承認ストラテジーのあるサブスクリプションの場合、Subscription タブからアップグレードを
手動で承認できます。

4.2. CAMEL K インテグレーションのアップグレード

Camel K Operator のアップグレードをトリガーすると、Operator はインテグレーションのアップグ
レードを準備しますが、サービスの中断を避けるためにアップグレードはトリガーされません。
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Operator をアップグレードする際に、インテグレーションカスタムリソースは自動的に新しいバー
ジョンにアップグレードされないため、たとえば Operator は 1.6.0 バージョンであるのに対して、イ
ンテグレーションは、カスタムリソースの status.version フィールドに以前のバージョンの 1.4.1 を報
告する可能性があります。

前提条件前提条件

Camel K Operator が Operator Lifecycle Manager (OLM) を使用してインストールおよびアップグレー
ドされている。

手順手順

ターミナルを開き、以下のコマンドを実行し、Camel K インテグレーションをアップグレード
します。

kamel rebuild myintegration

これにより、インテグレーションリソースのステータスがクリアされ、Operator はアップグレードさ
れたバージョン (例: バージョン 1.6.0) からのアーティファクトを使用してインテグレーションのデプロ
イメントを開始します。

4.3. CAMEL K のダウングレード

以前のバージョンのオペレーターをインストールすることにより、古いバージョンの Camel K オペレー
ターにダウングレードできます。これは、OCCLI を使用して手動でトリガーする必要があります。CLI
を使用した特定バージョンの Operator のインストールに関する詳細は、Installing a specific version of
an Operator を参照してください。

重要重要

OLM ではダウングレードがサポートされていないため、既存の Camel K オペレーターを
削除してから、特定のバージョンのオペレーターをインストールする必要があります。

古いバージョンの operator をインストールしたら、kamel rebuild コマンドを使用して統合を
operator バージョンにダウングレードします。以下に例を示します。

kamel rebuild myintegration
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第5章 CAMEL K クイックスタートの開発者チュートリアル
Red Hat Integration - Camel K は、https://github.com/openshift-integration のインテグレーション
ユースケースを基にした、クイックスタートの開発者チュートリアルを提供します。本章では、以下の
チュートリアルを設定およびデプロイする方法について説明します。

「基本的な Camel K Java インテグレーションのデプロイ」

「Knative での Camel K Serverless インテグレーションのデプロイ」

「Camel K 変換インテグレーションのデプロイ」

「Camel K Serverless イベントストリーミングインテグレーションのデプロイ」

「Camel K Serverless API ベースのインテグレーションのデプロイ」

「Camel K SaaS インテグレーションのデプロイ」

「Camel K JDBC 統合のデプロイ」

「Camel K JMS 統合のデプロイメント」

「Camel K Kafka 統合のデプロイ」

5.1. 基本的な CAMEL K JAVA インテグレーションのデプロイ

このチュートリアルでは、OpenShift のクラウドで簡単な Java インテグレーションを実行する方法、
設定およびルーティングをインテグレーションに適用する方法、およびインテグレーションを
Kubernetes CronJob として実行する方法を実証します。

前提条件前提条件

GitHub https://github.com/openshift-integration/camel-k-example-basic/tree/1.6.x のチュー
トリアル readme を確認します。

Camel K Operator および kamel CLI がインストールされている必要があります。Camel K のイ
ンストール を参照してください。

Visual Studio (VS) コードは任意ですが、最良の開発者エクスペリエンスを提供するために推奨
されます。Camel K 開発環境の設定  を参照してください。

手順手順

1. チュートリアル Git リポジトリーのクローンを作成します。

2. VS Code で File → Open Folder → camel-k-example-basic  と選択します。

3. VS Code ナビゲーションツリーで、readme.didact.md ファイルを右クリックし、Didact:
Start Didact Tutorial from File を選択します。以下に例を示します。

$ git clone git@github.com:openshift-integration/camel-k-example-basic.git
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これにより、VS Code に新しい Didact タブが開き、チュートリアルの手順が表示されます。

4. チュートリアルの手順に従い、提供されるリンクをクリックしてコマンドを自動的に実行しま
す。
VS Code が Didact エクステンションとともにインストールされていない場合に
は、https://github.com/openshift-integration/camel-k-example-basic からコマンドを手動で
入力できます。

関連情報関連情報

Java での Camel K インテグレーションの開発

5.2. KNATIVE での CAMEL K SERVERLESS インテグレーションのデプロ
イ

このチュートリアルでは、イベント駆動型のアーキテクチャーで OpenShift Serverless と Camel K イン
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テグレーションをデプロイする方法を説明します。このチュートリアルでは、Bitcoin 取引のデモンス
トレーションでイベントパブリッシュ/サブスクライブパターンを使用して、通信に Knative Eventing
ブローカーを使用します。

このチュートリアルでは、Camel K インテグレーションを使用して、複数の外部システムを持つ
Knative イベントメッシュに接続する方法についても説明します。Camel K インテグレーションは、必
要に応じて自動的にゼロにスケーリングするために Knative Serving も使用します。

前提条件前提条件

GitHub https://github.com/openshift-integration/camel-k-example-knative/tree/1.6.x の
チュートリアル readme を確認します。

Camel K および OpenShift Serverless をインストールするために、クラスター管理者として
OpenShift クラスターにアクセスできる必要があります。

Camel K のインストール

OperatorHub からの OpenShift Serverless のインストール

Visual Studio (VS) コードは任意ですが、最良の開発者エクスペリエンスを提供するために推奨
されます。Camel K 開発環境の設定  参照してください。

手順手順

1. チュートリアル Git リポジトリーのクローンを作成します。

2. VS Code で File → Open Folder → camel-k-example-knative  を選択します。

3. VS Code ナビゲーションツリーで、readme.didact.md ファイルを右クリックし、Didact:
Start Didact Tutorial from File を選択します。これにより、VS Code に新しい Didact タブが
開き、チュートリアルの手順が表示されます。

4. チュートリアルの手順に従い、提供されるリンクをクリックしてコマンドを自動的に実行しま
す。
VS Code が Didact エクステンションとともにインストールされていない場合に
は、https://github.com/openshift-integration/camel-k-example-native からコマンドを手動で
入力できます。

関連情報関連情報

About Knative Eventing

About Knative Serving

5.3. CAMEL K 変換インテグレーションのデプロイ

このチュートリアルでは、XML などのデータを JSON に変換し、PostgreSQL などのデータベースに
保存する Camel K Java インテグレーションを OpenShift で実行する方法を実証します。

チュートリアルの例では、CSV ファイルを使用して XML API をクエリーし、収集したデータを使用し
て、PostgreSQL データベースに保存される有効な GeoJSON ファイルをビルドします。

前提条件前提条件

$ git clone git@github.com:openshift-integration/camel-k-example-knative.git
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前提条件前提条件

GitHub https://github.com/openshift-integration/camel-k-example-transformations/tree/1.6.x
のチュートリアル readme を確認している。

Camel K をインストールするために、クラスター管理者として OpenShift クラスターへアクセ
スできる必要があります。Camel K のインストール  を参照してください。

チュートリアルの readme の手順に従い、OpenShift クラスターで必要な Dev4Ddevs.com に
よる PostgreSQL Operator をインストールする必要があります。

Visual Studio (VS) コードは任意ですが、最良の開発者エクスペリエンスを提供するために推奨
されます。Camel K 開発環境の設定  参照してください。

手順手順

1. チュートリアル Git リポジトリーのクローンを作成します。

2. VS Code で File → Open Folder → camel-k-example-transformations を選択します。

3. VS Code ナビゲーションツリーで、readme.didact.md ファイルを右クリックし、Didact:
Start Didact Tutorial from File を選択します。これにより、VS Code に新しい Didact タブが
開き、チュートリアルの手順が表示されます。

4. チュートリアルの手順に従い、提供されるリンクをクリックしてコマンドを自動的に実行しま
す。
VS Code が Didact エクステンションとともにインストールされていない場合に
は、https://github.com/openshift-integration/camel-k-example-transformations からコマンド
を手動で入力できます。

関連情報関連情報

https://operatorhub.io/operator/postgresql-operator-dev4devs-com

https://geojson.org/

5.4. CAMEL K SERVERLESS イベントストリーミングインテグレーション
のデプロイ

このチュートリアルでは、イベント駆動型のアーキテクチャーに Camel K と Knative Eventing のある
OpenShift Serverless を使用する方法を実証します。

このチュートリアルでは、Camel K と Knative のある Serverless を AMQ Broker クラスターのある
AMQ Streams クラスターにインストールする方法と、イベントストリーミングプロジェクトをデプロ
イして、グローバルハザードアラートデモンストレーションアプリケーションを実行する方法も実証し
ます。

前提条件前提条件

GitHub https://github.com/openshift-integration/camel-k-example-event-
streaming/tree/1.6.x のチュートリアル readme を確認します。

Camel K および OpenShift Serverless をインストールするために、クラスター管理者として

$ git clone git@github.com:openshift-integration/camel-k-example-transformations.git

Red Hat Integration 2022.Q2 Camel K のスタートガイドのスタートガイド

28

https://github.com/openshift-integration/camel-k-example-transformations/tree/1.6.x
https://access.redhat.com/documentation/ja-jp/red_hat_integration/2022.Q2/html-single/getting_started_with_camel_k#installing-camel-k
https://access.redhat.com/documentation/ja-jp/red_hat_integration/2022.Q2/html-single/getting_started_with_camel_k#setting-up-environment
https://github.com/openshift-integration/camel-k-example-transformations
https://operatorhub.io/operator/postgresql-operator-dev4devs-com
https://geojson.org/
https://github.com/openshift-integration/camel-k-example-event-streaming/tree/1.6.x


Camel K および OpenShift Serverless をインストールするために、クラスター管理者として
OpenShift クラスターにアクセスできる必要があります。

Camel K のインストール

OperatorHub からの OpenShift Serverless のインストール

チュートリアル readme の手順に従って、OpenShift クラスターで必要な追加の Operator をイ
ンストールする必要があります。

AMQ Streams Operator

AMQ Broker Operator

Visual Studio (VS) コードは任意ですが、最良の開発者エクスペリエンスを提供するために推奨
されます。Camel K 開発環境の設定  参照してください。

手順手順

1. チュートリアル Git リポジトリーのクローンを作成します。

2. VS Code で File → Open Folder → camel-k-example-event-streaming  と選択します。

3. VS Code ナビゲーションツリーで、readme.didact.md ファイルを右クリックし、Didact:
Start Didact Tutorial from File を選択します。これにより、VS Code に新しい Didact タブが
開き、チュートリアルの手順が表示されます。

4. チュートリアルの手順に従い、提供されるリンクをクリックしてコマンドを自動的に実行しま
す。
VS Code が Didact エクステンションとともにインストールされていない場合に
は、https://github.com/openshift-integration/camel-k-example-event-streaming からコマン
ドを手動で入力できます。

関連情報関連情報

Red Hat AMQ のドキュメント

OpenShift Serverless のドキュメント

5.5. CAMEL K SERVERLESS API ベースのインテグレーションのデプロイ

このチュートリアルでは、API ベースのインテグレーションに Camel K と Knative Serving のある
OpenShift Serverless を使用する方法と、OpenShift で 3scale API Management のある API を管理する
方法を実証します。

このチュートリアルは、Amazon S3 ベースのストレージの設定方法、OpenAPI 定義の設計方法、およ
びデモンストレーション API エイドポイントを呼び出すインテグレーションの実行方法を示していま
す。

前提条件前提条件

GitHub https://github.com/openshift-integration/camel-k-example-api/tree/1.6.x のチュート
リアル readme を確認します。

Camel K および OpenShift Serverless をインストールするために、クラスター管理者として

$ git clone git@github.com:openshift-integration/camel-k-example-event-streaming.git
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Camel K および OpenShift Serverless をインストールするために、クラスター管理者として
OpenShift クラスターにアクセスできる必要があります。

Camel K のインストール

OperatorHub からの OpenShift Serverless のインストール

任意の Red Hat Integration - 3scale Operator を OpenShift システムにインストールして API
を管理することも可能。Deploying 3scale using the Operator を参照してください。

Visual Studio (VS) コードは任意ですが、最良の開発者エクスペリエンスを提供するために推奨
されます。Camel K 開発環境の設定  参照してください。

手順手順

1. チュートリアル Git リポジトリーのクローンを作成します。

2. VS Code で File → Open Folder → camel-k-example-api  と選択します。

3. VS Code ナビゲーションツリーで、readme.didact.md ファイルを右クリックし、Didact:
Start Didact Tutorial from File を選択します。これにより、VS Code に新しい Didact タブが
開き、チュートリアルの手順が表示されます。

4. チュートリアルの手順に従い、提供されるリンクをクリックしてコマンドを自動的に実行しま
す。
VS Code が Didact エクステンションとともにインストールされていない場合に
は、https://github.com/openshift-integration/camel-k-example-api からコマンドを手動で入
力できます。

関連情報関連情報

Red Hat 3scale API Management ドキュメント

OpenShift Serverless のドキュメント

5.6. CAMEL K SAAS インテグレーションのデプロイ

このチュートリアルでは、広く使用されている 2 つのソフトウェアを SaaS (Software as a Service) プ
ロバイダーとして接続する Camel K Java インテグレーションを OpenShift で実行する方法を実証しま
す。

チュートリアルの例は、REST ベースの Camel コンポーネントを使用して Salesforce および
ServiceNow の SaaS プロバイダーを統合する方法を示しています。簡単なこの例では、新しい
Salesforce Case はそれぞれ Salesforce Case Number が含まれる該当の ServiceNow Incident にコピー
されます。

前提条件前提条件

GitHub https://github.com/openshift-integration/camel-k-example-saas/tree/1.6.x のチュート
リアル readme を確認します。

Camel K をインストールするために、クラスター管理者として OpenShift クラスターへアクセ
スできる必要があります。Camel K のインストール  を参照してください。

$ git clone git@github.com:openshift-integration/camel-k-example-api.git
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Salesforce のログインクレデンシャルと ServiceNow のログインクレデンシャルが必要です。

Visual Studio (VS) コードは任意ですが、最良の開発者エクスペリエンスを提供するために推奨
されます。Camel K 開発環境の設定  参照してください。

手順手順

1. チュートリアル Git リポジトリーのクローンを作成します。

2. VS Code で File → Open Folder → camel-k-example-saas  と選択します。

3. VS Code ナビゲーションツリーで、readme.didact.md ファイルを右クリックし、Didact:
Start Didact Tutorial from File を選択します。これにより、VS Code に新しい Didact タブが
開き、チュートリアルの手順が表示されます。

4. チュートリアルの手順に従い、提供されるリンクをクリックしてコマンドを自動的に実行しま
す。
VS Code が Didact エクステンションとともにインストールされていない場合に
は、https://github.com/openshift-integration/camel-k-example-saas からコマンドを手動で入
力できます。

関連情報関連情報

https://www.salesforce.com/

https://www.servicenow.com/

5.7. CAMEL K JDBC 統合のデプロイ

このチュートリアルでは、JDBC ドライバーを介して Camel K と SQL データベースの使用を開始する
方法を示します。このチュートリアルでは、Postgres データベースにデータを生成する統合をセット
アップする方法 (任意のリレーショナルデータベースを使用できる) と、同じデータベースからデータを
読み取る方法を示します。

前提条件前提条件

GitHub https://github.com/openshift-integration/camel-k-example-jdbc/tree/1.6.x のチュート
リアル readme を確認します。

Camel K をインストールするためにクラスター管理者として OpenShift クラスターへアクセス
できる必要があります。

Camel K のインストール

Visual Studio (VS) コードは任意ですが、最良の開発者エクスペリエンスを提供するために推奨
されます。Camel K 開発環境の設定  参照してください。

手順手順

1. チュートリアル Git リポジトリーのクローンを作成します。

$ git clone git@github.com:openshift-integration/camel-k-example-saas.git

$ git clone git@github.com:openshift-integration/camel-k-example-jdbc.git
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2. VS Code で File → Open Folder → camel-k-example-jdbc  と選択します。

3. VS Code ナビゲーションツリーで、readme.didact.md ファイルを右クリックし、Didact:
Start Didact Tutorial from File を選択します。これにより、VS Code に新しい Didact タブが
開き、チュートリアルの手順が表示されます。

4. チュートリアルの手順に従い、提供されるリンクをクリックしてコマンドを自動的に実行しま
す。
VS Code が Didact エクステンションとともにインストールされていない場合に
は、https://github.com/openshift-integration/camel-k-example-jdbc からコマンドを手動で入
力できます。

関連情報関連情報

独自の Postgres サンプルデータベースの作成

5.8. CAMEL K JMS 統合のデプロイメント

このチュートリアルでは、JMS を使用してメッセージブローカーに接続し、メッセージを消費および
生成する方法を示します。2 つの例があります。

JMS シンク: このチュートリアルでは、JMS ブローカーへのメッセージを生成する方法を示し
ます。

JMS ソース: このチュートリアルは、JMS ブローカーからのメッセージを使用する方法を示し
ています。

前提条件前提条件

GitHub https://github.com/openshift-integration/camel-k-example-jms/tree/1.6.x のチュート
リアル readme を確認します。

Camel K をインストールするためにクラスター管理者として OpenShift クラスターへアクセス
できる必要があります。

Camel K のインストール

Visual Studio (VS) コードは任意ですが、最良の開発者エクスペリエンスを提供するために推奨
されます。Camel K 開発環境の設定  参照してください。

手順手順

1. チュートリアル Git リポジトリーのクローンを作成します。

2. VS Code で File → Open Folder → camel-k-example-jms  と選択します。

3. VS Code ナビゲーションツリーで、readme.didact.md ファイルを右クリックし、Didact:
Start Didact Tutorial from File を選択します。これにより、VS Code に新しい Didact タブが
開き、チュートリアルの手順が表示されます。

4. チュートリアルの手順に従い、提供されるリンクをクリックしてコマンドを自動的に実行しま
す。

VS Code が Didact エクステンションとともにインストールされていない場合に

$ git clone git@github.com:openshift-integration/camel-k-example-jms.git
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VS Code が Didact エクステンションとともにインストールされていない場合に
は、https://github.com/openshift-integration/camel-k-example-jms からコマンドを手動で入
力できます。

関連情報関連情報

JMS シンク

JMS ソース

5.9. CAMEL K KAFKA 統合のデプロイ

このチュートリアルでは、Apache Kafka で Camel K を使用する方法を示します。このチュートリアル
では、Red Hat OpenShift Streams for Apache Kafka を介して Kafka トピックを設定し、Camel K と組
み合わせて使用する方法を示します。

前提条件前提条件

GitHub https://github.com/openshift-integration/camel-k-example-kafka/tree/1.6.x のチュー
トリアル readme を確認します。

Camel K をインストールするためにクラスター管理者として OpenShift クラスターへアクセス
できる必要があります。

Camel K のインストール

Visual Studio (VS) コードは任意ですが、最良の開発者エクスペリエンスを提供するために推奨
されます。Camel K 開発環境の設定  参照してください。

手順手順

1. チュートリアル Git リポジトリーのクローンを作成します。

2. VS Code で File → Open Folder → camel-k-example-kafka と選択します。

3. VS Code ナビゲーションツリーで、readme.didact.md ファイルを右クリックし、Didact:
Start Didact Tutorial from File を選択します。これにより、VS Code に新しい Didact タブが
開き、チュートリアルの手順が表示されます。

4. チュートリアルの手順に従い、提供されるリンクをクリックしてコマンドを自動的に実行しま
す。
VS Code が Didact エクステンションとともにインストールされていない場合に
は、https://github.com/openshift-integration/camel-k-example-kafka からコマンドを手動で
入力できます。

$ git clone git@github.com:openshift-integration/camel-k-example-kafka.git
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https://access.redhat.com/documentation/ja-jp/red_hat_integration/2022.Q2/html-single/getting_started_with_camel_k#setting-up-environment
https://github.com/openshift-integration/camel-k-example-kafka
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